
1. I'm unhappy 
about the choice 
of graphics that 
Metamorphosis 
has made to 
insert in my 
lesson. Is there 
anything I can do 
about it? 

Yes, there are a number of things you could try: 

1. Restrict the graphic type that Metamorphosis is to use. For 

example, if you wanted only colour photographs to be used then 

you would need to: 

o Go to the Settings pane 

o Select the Graphics option 

o Under Graphic type(s) to include uncheck every option 

except for Color photos. 

2. Prioritise the library graphic categories. This means 

Metamorphosis will first attempt to find graphics from the 

categories you nominate. Refer to the Prioritising the graphics 

categories section for more information. 

3. If you are expecting Metamorphosis to include graphics from its 

library, and it isn't, then you need to: 

o Go to the Settings pane 

o Select the Graphics option 

o Under Library Graphics, check the Automatically add 

graphics from library option. 

4. If you are expecting Metamorphosis to include graphics from your 

source document, and it isn't, then you need to: 

o Go to the Settings pane 

o Select the Graphics option 

o Check the Include graphics from source document option. 

5. Replace the graphics in the Edit tab using the Add/Replace 

graphics button. 

 

2. I have a 
document that is 
essentially one 
huge table that 
I'm having 
trouble 
converting 
satisfactorily. 
What can I do 
about it? 

While Metamorphosis accepts virtually any Word document there are 

cases that cannot be converted satisfactorily. A multi-page document that 

consists of one long table, such as might be used by an interactive movie 

script will not convert well. Metamorphosis cannot determine the best way 

to layout the text it finds. 

To deal with the problem, highlight the table, select the Convert Table to 

Text command in the Word Table menu and then rearrange the text until it 

makes sense. It is now ready to be converted by Metamorphosis. 

 

3. I'm unable to 
view an entire 
web page at one 
time without 
scrolling to view 
the hidden parts. 
What should I 
do? 

1. Make sure that your monitor is set to a resolution of at least 1024 

by 768 pixels. To change the resolution: 

o Go to Start > Settings > Control Panel > Display 

o The Display Properties dialog box appears 

o Click on the Settings tab 

o On this tab sheet there is a pane labelled Screen resolution 

o Drag the tracking block to change the resolution 

o Click the OK button and follow any on screen instructions. 

2. You may need to maximise Internet Explorer (IE). To do this, do 

one of the following: 

o Double click on Internet Explorer's title bar 



o Single click on the small icon on IE's title bar and select 

Maximize from the popup menu that appears 

o Right mouse click on the IE on the task bar and select 

Maximize from the popup menu that appears 

o Single click on the maximize system button (the middle 

button of the three buttons on the right hand side of IE's 

title bar 

 

4. How can I let 
Metamorphosis 
know that I've 
moved the 
graphics library 
to a new 
location? 

If the graphics library has been moved you can use the File menu item 

Preferences / Set graphics library location... to point at the new location. 

The graphics library is contained within a folder called "Library". This 

folder should not be renamed. When the graphics library is moved it is this 

"Library" folder that is moved. When you set a new location, it is the 

"Library" folder that you need to locate - not any of its sub-folders. 

 

5. When I publish 
a standalone 
version an 
Index.hta file is 
created. What is 
it for?  

It is only meant for use locally under Windows XP SP2. 

Windows XP SP2 introduced enhanced security procedures. One of which 

was to block "active content" (active content includes JavaScript, Java 

applets, Flash, ActiveX controls...) in a file that is run on the local machine 

(My Computer) in the hope that it would prevent malicious code from 

automatically running. 

By the way, although their names are similar "Java" and "JavaScript" are 

totally separate and unrelated entities. 

To prevent the warning messages from appearing and to allow a project 

with active content to run correctly do one of the following: 

 On Windows computers, run Index.HTA instead of Index,HTM 

 Use a different modern browser to IE eg. Firefox 

 Host the project on a server (in which case do not upload 

Index.HTA) 

 In IE go to the menu item Tools / Internet Options; click the 

Advanced tab; scroll down to the Security branch and check the 

checkbox next to the item "Allow active content to run in files on 

My Computer". Warning: this will change the security setting for 

all files run on My Computer. 

 

6. When I publish 
a standalone 
version and run it 
locally under IE 
some images do 
not appear. 

Sometimes I do see the images flash on and then disappear. 

This most likely because one of the folders that contains the published 

project contains one of more "non internet safe" characters (such as "("). 

Rename any "non internet safe" characters in all containing folders to, say, 



alphanumeric characters and all missing images should appear. 

 

7. Why does it, 
when I try to 
save/publish 
Metamorphosis 
project across a 
network, 
misbehave/fail? 

More than likely it's because your network drive uses a UNC (Universal 

Naming Convention) based path. While UNC is a more flexible standard 

(as it allows you to identify a server by name without worrying about a 

drive letter assignment) the current version of MM has only been tested on 

network drives that have been mapped to a drive letter. For example, MM 

will save to a folder on the K:\projects drive but not to 

\\serverpath\projects even though the folders are actually the same. 

To Map a Network Drive: 

1. Open Windows Explorer. (If you cannot find Windows Explorer, 

right-click on the Start menu and choose Explore.) 

2. Select the Tools menu, then select Map Network Drive. 

3. Under Drive, choose a drive letter from the pull-down menu and 

select the drive to connect to. Select 'Reconnect at logon'. 

4. Click Finish. 

5. To disconnect your network drive go to: Tools > Disconnect 

Network Drive - select the drive you wish to disconnect. 

 

8. How can I use 
Metamorphosis 
without requiring 
the CD Rom in 
the drive all the 
time? 

If you did the typical install of Metamorphosis then the library graphics 

remain on the CD Rom. This means that each time you run the program 

Metamorphosis will look for the library graphics on the CD Rom - and 

give you an error if it can't locate it. To prevent it from looking for the CD 

Rom you can do one of the following: 

 Under Settings / Graphics uncheck the checkbox labelled 

'Automatically add graphics from library'. This means 

Metamorphosis will never try to use one of it library graphics and 

so not try to access the CD Rom. 

 When you install Metamorphosis choose the option that loads the 

library graphics with your install - the library graphics get installed 

with the program. 

 Copy the entire folder from the CD Rom called 'Library' (which is 

about 550MB in size) to a drive-based path that is available to your 

computer, or simply to your hard drive. Then point Metamorphosis 

to the new location. Metamorphosis will now look for its library 

graphics in this 'Library' folder. 

 

9. When I test an 
ASP web-
published version 
of my project on 
the web server I 
get an "operation 
must use an 

The answer is from Microsoft's Article ID 175168 which says: 

"The most common reason is that the Internet Guest account 

(IUSR_MACHINE), which is by default part of the 'Everyone' group, does 

not have Write permissions on the database file (.mdb). To fix this 

problem, use the Security tab in Explorer to adjust the properties for this 



updateable 
query", or 
similar, error.  

file so that the Internet Guest account has the correct permissions." 

It's often not enough to just move your files to your web server. 

Metamorphosis cannot change settings on your web server so it's up to you 

to give both your ASP files and the database appropriate permissions. 

 

10. How do I 
prepare a source 
Word document 
that I want to 
import as a quiz?  

If you wish Metamorphosis to automatically recognise multiple choice 

questions in your Word documents (so it can automatically create the 

questions within Metamorphosis) you must first prepare the questions in 

your Word document by applying appropriate styles. 

Once you have typed your questions, use the custom Word style stem for 

the questions themselves, the custom Word style option for distractors, 

and the custom Word style optionyes for the correct answer(s). Avoid 

having these style names on any other element anywhere else in your 

document or Metamorphosis will become 'confused' and will not properly 

generate the quiz. 

If you want to have more control over your quiz, make it the last topic in 

your lesson and then nominate the last topic as an Assessment topic in the 

Assessment category of the Metamorphosis' Settings pane. Then you will 

be able to specify question time limits, randomization, pooling... 

 

11. Information is 
stored in an MS 
Access database 
where the date is 
split over three 
fields. How do I 
combine the 
three fields into 
one? 

To combine the three "date" fields in your MS Access database into one 

date field use a macro (an automated sequence of commands that provide a 

specific function). To create a macro do the following: 

1. Open your database in MS Access. 

2. Select 'Macros' from the left hand Objects pane. 

3. Select 'New' and the macro design window appears. 

4. Add the following 6 actions in order. 

5. Close and save the macro window. 

6. To run the macro either double-click on it or select it and click the 

'Run' icon. 

Notes: 

 The options go in the bottom left hand area of the window. 

 If you don't want the existing date fields deleted omit the last 3 

actions. 

 I've assumed the existing table name is "Table1" if it isn't then 

change all instances of "Table1" to the actual table name. 

 I've assumed the copy of the table is to named "Table1Copy" if it 

isn't then change all instances of "Table1Copy" to the actual table 

name. 

 Each SQL Statement goes on one line (they probably here display 

as wrapping). 



 A macro may be copied and pasted from one database to another. 

Actions: 

Action: CopyObject 

Options: 

Destination database: [leave blank] 

New Name: Table1Copy 

Source Object Type: Table 

Source Object Name Table1 

Action: RunSQL 

Options: 

SQL Statement: ALTER TABLE Table1Copy ADD COLUMN 

CompleteDate DATETIME; 

Use Transaction: No 

Action: RunSQL 

Options: 

If your standard date format is month/day/year use the following 

line: 

SQL Statement: UPDATE Table1Copy SET CompleteDate = 

CDate(CStr([CourseDay])+"/"+CStr([CourseMonth])+"/"+CStr([C

ourseYear])); 

If, instead, your standard date format is day/month/year use the 

following line: 

SQL Statement: UPDATE Table1Copy SET CompleteDate = 

CDate(CStr([CourseDay])+"/"+CStr([CourseMonth])+"/"+CStr([C

ourseYear])); 

[At any rate you should test a small table and see if the results you 

get are what you expect.] 

Use Transaction: No 

Action: RunSQL 

Options: 

SQL Statement: ALTER TABLE Table1Copy DROP COLUMN 

CourseDay; 

Use Transaction: No 

Action: RunSQL 

Options: 

SQL Statement: ALTER TABLE Table1Copy DROP COLUMN 

CourseMonth; 

Use Transaction: No 

Action: RunSQL 

Options: 

SQL Statement: ALTER TABLE Table1Copy DROP COLUMN 

CourseYear; 

Use Transaction: No 
 

12. I've specified 
some settings for 
the assessment 
topic but the 

For an assessment topic if you want to: 

1. Randomise the question order 

o in the assessment tab, by checking the box "Present 



published project 
is not behaving 
as I would expect 
it to. 

questions in random order" 

2. Set the number of questions 

o in the assessment tab, by checking the box "Set the number 

of questions to present from the total pool of questions" 

The assessment topic questions must be: 

 at the root level of the assessment topic (not in a sub 

topic/container) 

 contiguous with other questions i.e. all the question must follow 

each other without any non-question screens between them. 

 

13. Once I import 
the documents to 
create a multi-
topic lesson how 
do I change the 
topic title that 
appears on the 
main menu? 

The topic titles can be changed in the Sorter, on the Edit pane, under the Tree 
(view) tab. Each topic appears as a folder icon. If you click twice (not a double-
click) on the text label for a topic then you can edit the label. Editing the label 
changes the title that appears on the main menu. 

14. How do I 
disable the 'Next' 
button?  

Metamorphosis allows for the disabling of the 'Next' button in a number of 

specific situations. Outside of these it is not directly possible to disable the 

'Next' button. Though, if you are prepared to do some hand coding then, 

there is a way: 

Note: this has been added to the Additional features utility so you don't 

need to hand code the following. 

First, from the published output locate the screen on which the 'Next' 

button is to be disabled. Then make a copy of the screen and put the copy 

somewhere safe. Using Notepad open the screen. 

The top of the opened screen will look something like this: 

 

< !DOCTYPE HTML PUBLIC "-//W3C//DTD HTML 4.01//EN" 

"http://www.w3.org/TR/html4/strict.dtd"> 

<html> 

<head> 

<title>Unt</title> 

<meta http-equiv="Content-Type" content="text/html;charset=iso-8859-

1"> 



<meta http-equiv="Content-Style" content="text/css"> 

<style type="text/css">@import url(scripts/Unt.css);</style> 

</head> 

Add the following after the STYLE element and before the end of the 

HEAD element:< script type="text/javascript"> 

window.onload = function() { parent.mph.disableNext(); }; 

</script> 

 

So the page now looks like this: 

 

< !DOCTYPE HTML PUBLIC "-//W3C//DTD HTML 4.01//EN" 

"http://www.w3.org/TR/html4/strict.dtd"> 

<html> 

<head> 

<title>Unt</title> 

<meta http-equiv="Content-Type" content="text/html;charset=iso-8859-

1"> 

<meta http-equiv="Content-Style" content="text/css"> 

<style type="text/css">@import url(scripts/Unt.css);</style> 

<script type="text/javascript"> 

window.onload = function() { parent.mph.disableNext(); }; 

</script> 

</head> 

 

Save the changes you've made to the screen and then test the published 

project. 

If there's a problem, reopen the screen with notepad and correct it. If you 

are unable to correct the problem then you'll need to replace the screen 

with its saved version and try again. 



 

15. I'm opening 
lesson from a 
custom-built 
menu across a 
secure 
connection but 
the lesson does 
not display 
properly. Is there 
a fix for this? 

Trying to open the lesson using relative paths in a JavaScript function call 

e.g. 

var win = window.open("../../my_lessons/lesson01/index.htm",... ) 

will not work. You need to use a full URI e.g. 

var win = 

window.open("http://www.mydomain.com/my_lessons/lesson01/index.ht

m",... ) 

 

16. I can neither 
preview nor 
publish my 
lesson. What's 
the problem?  

It can be one of two possibilities. 

First, in the ye olde DOS days Microsoft reserved these words: CON, 

PRN, AUX, NUL, COM1, COM2, COM3, COM4, COM5, COM6, 

COM7, COM8, COM9, LPT1, LPT2, LPT3, LPT4, LPT5, LPT6, LPT7, 

LPT8, and LPT9. 

You cannot name a file with a reserved word even if you add an 

extensions e.g "CON.doc" or "con.Doc" or "Con.DOC"... (the reservations 

are case insensitive). Apparently this restriction is in force with today's 

Microsoft Windows. 

It is the three-letter reserved words that are of concern: CON, PRN, AUX, 

and NUL. 

When Metamorphosis 2 previews or publishes a project it creates a style 

sheet for the project using the first three letters of the project's name. 

Unfortunately if those letters match one of the reserved words then 

Windows will not allow the style sheet to be created. Without the style 

sheet the project can neither preview nor publish. For example, if a project 

is named "Consulting.MPH" then the style sheet would be named 

"CON.CSS" which Windows will not allow to be created. 

Note that here we are talking about the name of your project file itself and 

not the project/lesson title that is displayed to the end user/student. 

The workaround is to ensure that your project does not start with one of 

the three-letter reserved words. If your project currently does, then simply 

change the project's (and the project's "support" folder's) name 

appropriately. For example, change the name from "Consulting.MPH" to 

"aConsulting.MPH". 

Note that Metamorphosis version 3+ allows you to name a project 

with a name that begins with any of the "reserved" words. 

Secondly, if you are using a custom theme the structure of the theme may 

have changed between different versions of Metamorphosis. You may 

http://www.mydomain.com/my_lessons/lesson01/index.htm
http://www.mydomain.com/my_lessons/lesson01/index.htm


need to update your custom theme so that it is compatible with the version 

of Metamorphosis you are using. 

 

17. On Windows 
Vista, 
Metamorphosis 
complains that it 
needs to be run 
at least once by 
someone with 
Administrator 
privileges but I'm 
an Administrator 
and it still won't 
run. 

The new security (UAC) setup in Vista is most likely the issue. Even 

though you are an Administrator, you will probably have to do a 'Run as 

Administrator' because, by default, Vista will start applications in non-

administrator mode. To do a one-time-only 'Run as Administrator', right-

mouce click on the icon or shortcut and choose 'Run As Administrator'. 

More detail is available here 

http://vistasupport.mvps.org/run_as_administrator.htm . 

 

18. When I try to 
upload a lesson 
my FTP program 
keeps failing.  

Some FTP programs will not accept file names that contain spaces. You 

should make certain that any content you import (graphics, video...) does 

not contain spaces. If you have imported content whose file name contains 

one or more spaces you'll need to rename the original content (i.e. remove 

the spaces from the file name) and to then re-import the content into your 

project. 

Also the default files that are published with some themes contain spaces 

e.g. "Deep Blue". Before you upload to a web server it is safe to delete 

these files in [published content folder]\content\scripts\pics: 

 [theme name].css 

 description.txt 

 mph.ico 

 screendump.jpg 

Note that if the problem is with an LMS-published lesson, and you delete 

the above files, then you will also need to manually delete references to 

the files in the file imsmanifest.xml. The manifest may be opened and 

edited with Windows Notepad. 

 

19. I keep getting 
an error that 
reads, "Cannot 
create a file 
when that file 
already exists" 
when I open or 
try to save my 
project.  

This error message can occur due to many different reasons - domain 

permissions, server too busy... 

Things to try to resolve it include: 

 Doing a "save as..." and the save the project to a different file 

name. 

 Not trying to open and/or save the project across a network 

particularly if the network drive is being accessed with a UNC 

path. Instead, work with the project locally and then later copy the 

project to the server. 

 Having your IT support check your domain permissions - a user 

http://vistasupport.mvps.org/run_as_administrator.htm


may be allowed to read/modify existing files but not allowed to 

create new files or folders. 

We suspect its a permissions/privileges issue: 

1. Make sure you have full access to your Metamorphosis "root" 

folder, its sub folders and files. That is to (typically): 

XP - C:\Documents and Settings\[user name]\Application 

Data\Apixel\Metamorphosis 

Vista - C:\users\[user 

name]\AppData\Roaming\Apixel\Metamorphosis 

2. Make sure you have access to the graphics library (the "Library" 

folder) its sub folders and files. 

3. Make sure that you don't have a security policy which only allows 

you to create files on certain drives and /or folders. 

 

20. How do I add 
my own graphics 
to the graphics 
library so that 
they will appear 
in graphics 
searched? 

First, making the necessary edits to allow this to happen is not something 

we support - beyond this FAQ note. So if you proceed, you do so at your 

own risk. 

All images for the graphics library reside in their respective folders in the 

"Library" folder. 

All images for the graphics library are managed via the XML file 

"Images.XML". 

There are four different types of supported images: 

1. In the folder "Library/Vector" are Windows Metafiles. 

Images with the extension .wmf. 

Within Images.XML these images are considered to be of the type: 

Vector 

2. In the folder "Library/Stock Photo b&w" are 8 bit grey scale JPEG 

images. 

Images with the extension .jpg. 

Within Images.XML these images are considered to be of the type: 

Stock Photo b&w 

3. In the folder "Library/Stock Photo color" are color JPEG images. 

Images with the extension .jpg. 

Within Images.XML these images are considered to be of the type: 

Stock Photo color 



4. In the folder "Library/Photo_Objects" are two sub-folders: 

In the folder "Library/Photo_Objects/image_JPG" are JPEG 

images. 

Images with the extension .jpg. 

In the folder "Library/Photo_Objects/mask" are 4 bit gray scale 

PNG images. 

Images with the extension .png. 

Each JPEG has a matching PNG image (a mask). A mask is like a 

stencil in that both have areas that are "open" and areas that are 

"closed". The closed areas make the areas of the JPEG image, that 

it covers, transparent. 

Within Images.XML these images are considered to be of the type: 

Photo Object 

 

Available Image Categories 

 Agriculture & Industry 

 Architecture 

 Business, Commerce & Trade 

 Education 

 Food & Beverages 

 Health & Safety 

 Holiday & Special Occasions 

 House & Home 

 Lifestyles & Culture 

 Nature 

 People 

 Religion, Myth & Fantasy 

 Science & Technology 

 Signs & Symbols 

 Social Issues & Government 

 Sports & Leisure 

 Transportation 

 Travel & Tourism 

 Wildlife & Animals 

 

Important Rules 

 Within Images.XML the ampersand (&) must be written as "&" 

(without the quotes). 

 An image's file name must be unique with respect to all other 

images in the library. 

 The actual image name is not important, as such. 

 All alphabetic characters in image file names are to be written in 

all lower case. 

 Do not include any spaces in image file names. 



 Do not include any "odd" characters in image file names e.g. 

&.~!@#$%^*(),-=+:"'<>?.`[]\|}{, letters with accents... 

 Make a backup copy of Images.XML before you commence to edit 

it. 

 

Before You Begin 

 Decide on keywords for each new image 

 Decide on what category each image best fits into e.g. 

"Architecture" (each image may only be of one category). 

 Decide on what image type each image is e.g. "Stock Photo - 

color" (each image may only be one image type). Note that "Photo 

Objects" consist of two images - an image and its corresponding 

mask. 

 Do not include any "odd" characters in keywords e.g. 

&.~!@#$%^*(),-=+:"'<>?.`[]\|}{, letters with accents... 

 Make a backup copy of Images.XML prior to editing it. 

 

Procedure to Edit Images.XML 

1. Place your images into the appropriate graphics library sub-folder. 

2. Open Image.xml with, say, Notepad. Its a relatively large file so it 

will be slow to respond - be patient. 

3. The initial line reads <images> 

4. Immediately after that add the following line once for each new 

image: 

<image><file>a</file><keywords>b</keywords><category>c</cat

egory><type>d</type></image> 

Where: 

a = the image's file name 

b = the keyword(s) 

Keywords consist of one or more single words enclosed in square 

brackets 

e.g. [keyword1][keyword2][keyword3]... 

c = the image category 

d = the image type 

5. Save the file. 

6. Open the file with Internet Explorer to test it. It will be very slow 

to open but if the XML file is well formed (doesn't contain any 

syntax errors) then you'll not see any error messages. If there is an 

error then you must fix it. 

7. Now test Metamorphosis using the updated graphics library and 

Images.XML. 

The Images.XML file and the new library images should now be ready to 

go. On the other hand, if problems persist and you cannot fix them then 



you can always revert back to your backup copy of Images.XML. 

 

21. Why do I 
have to keep 
entering the 
activation code 
each time I 
launch 
Metamorphosis? 

The first time Metamorphosis is run it needs to be run by someone with 

Administration privileges so that the activation code may be stored to the 

computer's registry. If the activation cannot be stored then each time 

Metamorphosis is launched the activation code will need to be re-entered. 

If you are running Windows Vista or Windows 7 and you are an 

administrator, applications may still not run even though you have 

Administration privileges. To run an application with Administration 

privileges right-mouse click on the application's icon and select Run as 

administrator. 

If you are still asked to re-enter the activation code each time you launch 

Metamorphosis then you have some computer security restriction or policy 

in place which is preventing Metamorphosis from updating your 

computer's registry. In which case, you'll need to ask your IT services to 

manually update the computer's registry with the following: 

If it doesn't already exist, create this new key 

HKEY_LOCAL_MACHINE\SOFTWARE\Apixel\Metamorph

osis 6 
Note that the number on the end of the key must match the version 

of Metamorphosis that you have. For example, for Metamorphosis 

version 5 the key name would be 

"HKEY_LOCAL_MACHINE\SOFTWARE\Apixel\Metamorphosi

s 5". 

To this key add a new string value titled "Activation Code" 

(without the quotes) and its value data is the activation code.  

Warning: Incorrectly editing your computer's registry may render 

your computer unusable. 
 

22. When trying 
to sign in or self-
register with a 
web-database 
published course 
I get the error, 
"The field is too 
small to accept 
the amount of 
data you 
attempted to 
add. Try inserting 
or pasting less 
data." This 
happens even if I 
insert just 1 
character. How 

If your course's name, including spaces, is more that 50 characters long 

then it will not fit into the default space allocated for it within the database 

table(s). 

Currently mph.mdb's CourseName field size is set to 50. 

Either shorten your course's name or open the database with MS Access (if 

you're using mph.mdb), open the table in Design View and change the size 

of the CourseName field to, say, 80 (do this for both tables 1 and 2). 

 



do I resolve this? 

23. Using the 
fade in/out Ken 
Burns effect on 
some images 
causes display 
issues. Can you 
explain what's 
happening?  

There are two known issues. 

First, with Internet Explorer to fade in or out a JPEG image, what's called, 

an opacity filter needs to be applied to the image. Currently there's a bug 

in Internet Explorer that will render all pure black (#000000) pixels of a 

JPEG as transparent. This bug doesn't happen on other browsers nor on 

PNG images. 

The only "solution" is to edit the image with photo editing software to 

remove/change all the pure black pixels in the image (or to not apply a 

fade effect). 

Secondly, with Internet Explorer, photo objects (PNG images with a 

transparency mask) may display with a dashed line around the visible 

perimeter of the image. This appears to be a bug in Internet Explorer when 

it applies an opacity filter to a photo object. This bug does not happen on 

other browsers. 

The only "solution" is to not apply a fade effect to a photo object. 

 

24. If I save and 
close my 
Metamorphosis 
project when I 
double-click it to 
re-open it opens 
with a different 
version of 
Metamorphosis. 
How can I open 
my project with 
the correct 
version of 
Metamorphosis? 

This probably can only happen if you have multiple versions of 

Metamorphosis installed. 

To change what application opens a particular kind of file (in this case its a 

Metamorphosis project file - it has a .MPH extension) do this: 

 Right-mouse click on the file 

 From the popup/context menu that appears select: Open With > 

Choose Default Program... 
 Check the box Always use the selected program to open this 

kind of file 
 Click the Browse... button and locate the application which you 

want to open this kind of file (see the note below). 

 Click the OK button. 

Now when you double-click your file it should open with the application 

you have nominated. 

 

Note, clicking the "Browser..." button means for you to open the folder in 

which the version of Metamorphosis you want to associate with .MPH 

project files is installed and then double-clicking on the Metamorphosis 

x.EXE file to select it. 

 

25. When I open 
a project, that 
I've previously 

If you open a project created with a newer version of Metamorphosis with 

an older version of Metamorphosis then your screens may not appear. 

Metamorphosis projects are forwards, not backwards, compatible. That is, 



been working on, 
the Edit pane is 
empty. Where 
have my screens 
gone? 

you can safely open projects created with older versions of Metamorphosis 

with a newer version of Metamorphosis. 

If you have multiple versions of Metamorphosis installed, double-clicking 

a project may open the project in a different version of Metamorphosis that 

the one you intended. First launch the intended version of Metamorphosis 

and then open your project from it. 

The safest thing we can suggest to do is to uninstall all versions - if a 

version exists after you run the uninstaller(s) delete it manually - and to 

reinstall just your most current version. 

 

26. When I try to 
open a project 
created with 
version 3 of 
Metamorphosis 
with version 4 I 
get an error that 
reads Failed to 
open document. 

All Metamorphosis 3 projects need to be opened and saved with the latest 
version 3 (3.404) for them to be correctly recognised by version 4. A bug in the 
internal numbering system in version 3 was discovered and fixed at version 
3.404. The internal numbering is used by Metamorphosis to identify a project, 
so early version 3 projects are not properly recognised by version 4. 

27. Questions 
that I expect to 
appear in an 
assessment do 
not appear. Why 
don't my 
questions 
appear? 

The most likely reason is that this box Settings > Last topic, or the linear 

course, is the assessment > Present question in random order is checked. 

When it is checked Metamorphosis can only present the questions that are 

contiguous with the first question it finds. All other questions are ignored. 

For example, if the screen layout in the assessment topic was n, q, q, q, q, 

q, n, q, q, q, f 

where 

n = normal 

q = question 

f = feedback 

Then the course will only display the first five questions. 

To display all questions uncheck the box 'Present question in random 

order'. 

 

28. Can you I use 
Metamorphosis 
on or across a 
network?  

The general answer is no. 

We do not support: 

1. Installing Metamorphosis onto a server, 

2. Publishing to a server, or 

3. Having a setup where Metamorphosis is installed locally but your 

user data folder is redirected to a network drive. 



It may work (especially with a change we made to version 5.010) in some 

situations but do not expect it to. Generally, you should always install and 

publish locally (later uploading any published content to your server). 

 

29. Why don't all 
my questions 
appear in my 
published 
course?  

If you check the box  

Settings > Assessment > Last topic... > Present questions in random order 

Metamorphosis can only select the questions from the first question it 

finds in the topic until a non-question screen is found. For example (here 

'q' is a question screen and 'n' is a non-question screen) if you have these 

screens in an assessment topic: 

n q1 q2 q3 n n n n q4 q5 q6 q7 n n n q8 n q9 n q10 

Metamorphosis will only select q1, q2, and q3 and ignore all the other 

questions. If you want all the questions you need to either 

- uncheck the box 'Present questions in random order' 

- put all the question contiguously eg. n n n n n q1 q2 q3 q4 q5 q6 q7 q8 

q9 q10 n n n n n 

- or if its a linear, single topic, course uncheck the box 

Settings > Assessment > Last topic... 

and check the box 

Import > Linear, single topic, course > All questions are assessable 

Though this last option changes the nature of the course. 

 

30. I'm interested 
in having the 
content area of 
my course to be 
in the proportion 
16 by 9. How do I 
do that? 

The following is only for users of Metamorphosis 6+. 

 

The size of the content area of a regular-sized course is 1008 x 560 pixels, 

which is 16 by 8.888. One possible size change to achieve 16 by 9 is to 

992 by 558 pixels. Given that the top and navigation bars are 60 pixels 

high this would mean that the course size needs to be changed to 992 by 

678 pixels. 

Note as the height change is only 2 pixels Metamorphosis does not change 

the height of the top or navigation bars. If you set a different height you 

may need to compensate for any resizing of the top and/or navigation bars. 

 

31. When I try to What the error means is that the Metamorphosis graphics library cannot be 



import a 
document I get 
an error which 
reads "Failed to 
find images in 
the following 
path:..." How do I 
resolve this 
images path 
error? 

found. You will need to: 

If the graphics library has not been installed , install the graphics library 

from the install CD to you computer. 

Or 

If the graphics library has in fact been installed then you will need to use 

the menu item: 

 File > Preferences > Set graphics library location... 

to point Metamorphosis to the library. 

Or 

If you have elected to keep the graphics library on the install disk, insert 

the disk into the disk drive before you try to import your document. If you 

hold down the Shift key (on your keyboard) as you insert the disk it will 

prevent the disk from auto-running. 

 

32. When I 
launch a 
Metamorphosis I 
get an error 
about an ordinal 
not being located 
in a dynamic link 
library. 

Metamorphosis expects to find some Microsoft supplied redistributables 

installed on your computer. These are usually available but there is a 

chance that may not be installed on your computer. Without them 

Metamorphosis cannot function correctly. 

Unfortunately the Metamorphosis installer cannot reliably check if the 

redistributables are installed. If you experience problems about ordinals in 

dynamic link libraries then you will need to download and install the 

following: 

1. MSXML 4.0 Service Pack 3 (Microsoft XML Core Services) from 

http://www.microsoft.com/downloads/en/details.aspx?FamilyID=7f6c0cb4

-7a5e-4790-a7cf-9e139e6819c0&displaylang=en 

Here the file to download and install is msxml.msi. 

 

2. Microsoft Visual C++ 2008 Redistributable Package (x86) from  

http://www.pacificm.com/downloads/vcredist_x86.exe  

If you prefer to source this installer directly from Microsoft the version 

that is required is "9.0.30729.5677". 

 

For your convenience these files are also available on the Metamorphosis 

http://www.microsoft.com/downloads/en/details.aspx?FamilyID=7f6c0cb4-7a5e-4790-a7cf-9e139e6819c0&displaylang=en
http://www.microsoft.com/downloads/en/details.aspx?FamilyID=7f6c0cb4-7a5e-4790-a7cf-9e139e6819c0&displaylang=en
http://www.pacificm.com/downloads/vcredist_x86.exe


installation CD. 

Note you will probably need to restart your computer after you install the 

above files for the changes to be available to your computer. 

 

33. My 
DropDown 
question won't 
validate. Why? 

Please note the following about drop down (DD) questions. 

They cannot validate if two or more items in an option are the same. For 

example: 

 word 1;word 2;word 2;word 4 

is bad. It should be 

 word 1;word 2;word 3;word 4 

Also its possible to cut and paste multi-line text into an option. An option 

should only contain a single line of text. The option's field is designed to 

only display a single line so there's no easy way to see if there's more than 

one line. If you have a field that you are not sure about: 

 click once in the field to give it focus 

 press Ctrl+A to select all the contents of the field 

 press Ctrl+C to copy the selected contents 

 paste the selected contents into Notepad. 

If there is more than one line then: 

 click once in the field to give it focus 

 press Ctrl+A to select all the contents of the field 

 press the Delete key to delete the contents 

 re-enter the contents correctly. 

 

 


